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This README file is provided as a reference document to help you setup your Windows 
environment or fix problems that you are having with Storybook Weaver.

Read Me contents:

• Hardware Requirements
• Installation Information
• User's Guide
• MECC Tour Information (Windows 95® only)
• Story Pack Information
• Troubleshooting Tips
• Helpful Information
• How to Contact Technical Support
• Copyright Responsibilities

======================== Hardware Requirements =======================

• 486 or higher
• Windows® 3.1 or later or Windows 95®
• 8MB RAM, 16MB RAM highly recommended
• Double-speed CD-ROM 
• 256 colors, 640 x 480
• Hard drive
• Windows-compatible mouse

Optional: Windows-compatible printer (for printing)
  Windows-compatible microphone (for voice recording)
  Windows-compatible sound-card

======================== Installation Information ========================

Windows 95

1. To install Storybook Weaver Deluxe, insert the CD in the drive and click on the Install
button after the MECC Tour screen appears.

Note: If no MECC Tour screen appears, click on Start in the Taskbar and select Run.  
Type D:\SETUP, where D: is the CD-ROM drive, and click OK. 

2. Follow the on-screen instructions. 

3. Installation will place Storybook Weaver Deluxe and MECC Tour icons in the Start menu
under the MECC program group.

4. Installation is now complete.  Click on Start in the taskbar, and select Programs. Move 



the mouse to the MECC folder and click on Storybook Weaver Deluxe icon to start the 
program.

Windows 95 Notes:

• Use the Windows 95 Add/Remove Programs icon in Control Panels to remove
Storybook Weaver Deluxe before reinstalling.  

• When the Storybook Weaver Deluxe CD is inserted, a MECC Tour screen will appear 
with Install, Run Storybook Weaver Deluxe, View Readme file, Connect to web page, 
Learn about MECC products, and Exit buttons. You can also run this file by clicking on 
Start in the Taskbar and selecting Run.  Type D:\MECCTOUR and click on OK, (where 
D: is your CD-ROM drive letter).

Windows 3.1x & Windows for Workgroups 3.11

1. From Program Manager, click on File and select Run.  

2. In the command line, type D:\SETUP, where D: is the CD-ROM drive, and click OK.  
Follow the on-screen instructions. 

3. Installation is now complete. Double-click on Storybook Weaver Deluxe icon in the 
MECC program group to start the program.

Windows 3.1x & Windows for Workgroups 3.11 Notes:

• Use the Windows File Manager to remove Storybook Weaver Deluxe before reinstalling.  

========== USER'S GUIDE ===============================

The User’s Guide for Storybook Weaver Deluxe is provided on the program CD in a folder 
called Manual. To view and/or print the User’s Guide, you will need to use the 
application Acrobat® Reader. 

Note: If you do not already have Acrobat Reader, you must first install the application on your 
hard disk before you can view and print out the User's Guide. We have included a copy of 
the Acrobat Reader on the Storybook Weaver Deluxe CD for your convenience.

INSTALLING ACROBAT READER

1. Insert the program CD into your CD-ROM drive.

2. For Windows 3.1 or higher: From the File menu, choose Run.... In the Command Line box, 
type D:\Manual\acro16.exe. (If your CD-ROM drive is not drive D, substitute for D the letter of 
the CD-ROM drive you are using.) Then press Enter.
  
For Windows 95: Click on the Start button.  From the Start menu, choose Run.... In the 
Command Line box, type D:\Manual\acroread.exe. (If your CD-ROM drive  is not drive D, 
substitute for D the letter of the CD-ROM drive you are using.) Then press Enter.

3. Follow the onscreen instructions to complete the installation.

PRINTING OUT THE USER'S GUIDE



1. Insert the program CD into your CD-ROM drive.

2. For Windows 3.1 or higher:
a. Open the Main program group.
b. Double-click on the File Manager icon.
c. Click on your CD-ROM icon at the top of the screen to select your CD-ROM drive.  
d. Double-click on the folder called MANUAL.
e. Double-click on the file entitled SBW.pdf to open the User’s Guide.

  For Windows 95:
a. Double-click on the My Computer icon.  
b. Double-click on the icon for your CD-ROM drive.
c. Double-click on the folder called MANUAL.
d. Double-click on the file entitled SBW.pdf to open the User’s Guide.

3. Choose Print from the File menu to print the User’s Guide.

================= MECC Tour Information (Windows 95 only) ================

Put Storybook Weaver Deluxe CD into the computer.  After a few seconds, the MECC Tour 
screen will appear.  Several options are available. 

Install - Puts the necessary Storybook Weaver Deluxe files on your computer's hard drive.

Run - Starts the installed version of Storybook Weaver Deluxe. This option is unavailable until the
product is installed.

View Readme file - Opens a file with additional information about the Storybook Weaver Deluxe. 
The file is opened in Notepad or WordPad.  You may access this file with any text editor.

Connect to web page - Launches your Internet web browser and connects to the MECC home 
page. The Internet connections offered by the MECC Tour menu work only if you have an Internet
connection and a browser which supports Internet shortcuts (i.e. Netscape 2.0 or Microsoft 
Internet Explorer 3.0).

If you have an Internet connection but your browser does not support shortcuts, you may wish to 
directly open one of the URLs listed below.

The Learning Company Home Page  = http://www.learningco.com

NOTE:  If you use a modem to connect to the Internet, remember to disconnect after quitting the 
browser.

Learn about MECC products - Displays product information and overviews about other MECC 
products.

Exit - Quits the MECC Tour.

Note: If no MECC Tour screen appears, click on Start in the Taskbar and select Run.  Type D:\
MECCTOUR\MECCTOUR, where D: is the CD-ROM drive, and click OK. 

========================= Story Pack Information ========================

Windows 95

If you had a previous version of Storybook Weaver Deluxe and the Story Packs, just copy the 



Resources and Tunes folders from the C:\MECC\SBWDLX directory into the C:\Program Files\
MECC\SBWDLX directory.

If you never had Storybook Weaver Deluxe or the Story Packs installed on your computer, run the
Story Pack installation accepting the default installation directory. Then copy the Resources and 
Tunes folders from that directory (C:\MECC\SBWDLX) to the C:\Program Files\MECC\SBWDLX 
directory.

Windows 3.1x & Windows for Workgroups 3.11

If you had a previous version of Storybook Weaver Deluxe and the Story Packs, delete the C:\
MECC\SBWDLX directory using File Manager. Also using File Manager, go into the C:\
WINDOWS directory and delete the SBW.INI file. Reinstall the Story Packs. When the installer 
asks where to install the Story Packs, just hit enter to accepting the default installation directory.

If you never had Storybook Weaver Deluxe or the Story Packs installed on your computer, run the
Story Pack installation accepting the default installation directory.

========================== Troubleshooting Tips =========================

Memory - RAM

Storybook Weaver Deluxe requires a minimum of 8 megabytes of random access memory (RAM)
to operate (16 megabytes of RAM are recommended).   Check that available memory is 
adequate. Although Windows allows you to run more than one application simultaneously, it is 
highly recommended that you close everything else to release all available memory before you 
run Storybook Weaver Deluxe. 

If you do not have a permanent swap file set up, it is recommended that you create one. 

Video Display

Storybook Weaver Deluxe requires 256 colors in a screen resolution of at least 640 x 480.

Windows 3.1x & Windows for Workgroups 3.11 Users:
To install the preferred 256-color video driver, use the "Windows Setup" icon (setup.exe) and take
the following steps: (Note: setup.exe can also be accessed from DOS when in the Windows 
directory.)

1. Locate your video card manufacturer's display drivers disk.

2. Find your Windows disks.

3. Find the Windows Setup Icon (setup.exe) in the Main Group.

4. Select Change System Settings from the Options menu.

5. In the pop-up menu, locate the Other Drivers selection.

6. Specify the drive and/or directory of the video display driver disk.

7. Select the driver which supports 640 x 480 in 256 colors, and click OK.

8. You may need to insert some of the Windows disks for fonts, etc.



9. To change to any other video mode, simply follow steps 1 through 8 for whatever mode 
required.

10.Once the above steps are completed, restart Windows.

Note that current drivers may be obtained directly from the video card manufacturer or from 
bulletin boards that are often set up by the video card manufacturers. Bulletin boards are 
databases that are accessible via a modem.
Sound and Music

There are a great number of manufacturers of MPC sound cards of varying qualities.  

1. Storybook Weaver Deluxe will have a small amount of "white noise" or background hiss
when playing digitized sound effects and speech.  It should not "crackle," "pop," or 
"motorboat."

2. If sound or music fails to play at all or the quality is still not as expected, then try 
reinstalling your sound card drivers as follows:

Locate your manufacturer's driver disk for the sound card that needs software 
installation. Also check your manual for any information regarding installation. Usually 
there is a set procedure for installation and most of the steps are done for you. Follow 
the manufacturer's procedures for installation.

If the manufacturer's installation is not successful, the following describes a more 
"manual" installation process:

1. Keep your Windows 3.1 disks handy. They're often needed for software 
installations.

2. Find the Windows Control Panel.

3. Click the Drivers Icon.

4. Find the Add button and click on it.

5. Scroll down to select "Other."

6. Insert your manufacturer's driver disk.

7. Click OK and follow the prompts.

8. If necessary, delete older drivers once the above steps are completed, and 
restart Windows.

9. Try installing Storybook Weaver Deluxe again or try the Sound Test to see if 
there is any improvement.

Description: Storybook Weaver Deluxe won't complete its installation.

Solution #1: Check the surface of the CD-ROM (the shiny side) for any smudges, scratches, 
fingerprints, or foreign substances.  Anything that can bend or obstruct light can cause incorrect 
data to be read.  Try cleaning the CD-ROM with a soft cotton cloth, wiping in a straight line from 
the center hole towards the outside edge.  Do not use paper towels, do not use any cleaning 



fluids, and do not wipe in a circle.

Description: I can't hear any sound or music.

Solution #2: Try using the MEDIA PLAYER that comes with Windows.  This will allow you to 
try MIDI or WAVE sounds (there are some .mid and .wav files in the Windows directory for you to 
try). From Program Manager, select RUN and type:  MPLAYER CANYON.MID or MPLAYER 
CHIMES.WAV.  Windows 95 users can click on Start in the taskbar, select Run and enter 
MPLAYER CANYON.MID or MPLAYER CHIMES.WAV.

Click the play button and you should hear music.  If you still don't hear anything, the problem is 
not just with Storybook Weaver Deluxe; it may be with the connection between your sound card 
and your speakers.  Check speaker connections, headphones, and volume controls.

Description: I'm still not hearing any sounds.

Solution #3: Look at the software mixer in Windows that came with your sound card.  Are the 
sliders for MIDI and WAVE turned up?  Is the master volume control turned up?  If you still do not 
hear sound/music, contact your computer and/or hardware manufacturer.

Description : I am getting error messages that Storybook cannot find the file ~SBW.

Solution #4: Add the command "SET TEMP = C:\WINDOWS\TEMP" in your AUTOEXEC.BAT 
file and restart your computer.

Description : Storybook Weaver Deluxe was working before, but now it isn't!

Solution #5: Check the surface of the CD-ROM (the shiny side) for any smudges, scratches, 
fingerprints, or foreign substances. Anything that can bend or obstruct light can cause incorrect  
data to be read.  Try cleaning the CD-ROM with a soft cotton cloth, wiping in a straight line from 
the center hole towards the outside edge.  Do not use paper towels, do not use any cleaning 
fluids, and do not wipe in a circle.

Description : A "System Error Cannot read from drive D" error message appears.

Solution #6: This error will occur if Storybook Weaver Deluxe CD is NOT in the drive. Also, 
check the surface of Storybook Weaver Deluxe CD-ROM (the shiny side) for any smudges, 
scratches, fingerprints, peanut butter or other foreign substances.  Anything that can bend or 
obstruct light can cause incorrect data to be read and can cause some bizarre errors to occur.

Description: A "Not enough memory to print" error message appears.

Solution #7: Save your story and exit Storybook Weaver Deluxe. Launch another program 
(like Paint or Write) and then relaunch Storybook Weaver Deluxe. Once Storybook Weaver 
Deluxe is running, close the other program and try to print again.

======================= General Troubleshooting Tips ======================

Rule #1 is to eliminate as many variables as possible!  

Windows 3.1x & Windows for Workgroups 3.11

•  Try turning off Sound and Music - does the error still occur?

•  Are any other programs running in the background?  Hold down the Ctrl & Esc keys to 



bring up the Windows task list.  Close all applications except Program Manager.  Then 
start Storybook Weaver Deluxe again.

•  DOS 6.0 and above allow users to step through the Config.sys and Autoexec.bat files, 
answering Yes or No for each line.  When your computer is starting up, a "Loading
MS-DOS" message appears.  Hold down the F8 key to step through these system files. 
Do not attempt this if you do not know what each line is doing.

NOTE: Check that you have the latest Windows drivers for the video and sound cards installed in 
your computer.  Check the documentation that came with your video card or sound card for 
information on obtaining updated drivers.

Windows 95

• Make sure there are no other programs running in the background.  Press Ctrl-Alt-Delete 
at the same time.  This will pop-up a Close Program window.  Try ending task on 
anything listed other than Explorer and Systray before starting the program.

=========================== Helpful Information ==========================

Delete Getting Started movie to save disk space
To conserve space on your hard drive, after viewing the Getting Started tutorial, delete it. The files
are easy to find. Look for TUTORIAL.AVI and TUTORSPN.AVI in the SBWDLX directory.

-----
Importing scanned images
You may have varied results when importing your original or scanned images. An image that is 
imported will have its colors adapted to the Storybook Weaver color set. This color set or palette 
has worked well for the Storybook Weaver images which are mostly of an illustration or cartoon 
quality. You may have to experiment with your images. Some images just won't work well with the
Storybook Weaver palette. If you import the image to the object editor, you can erase unwanted 
areas. These erased areas are invisible when the image is saved to the main story page.

-----
Avoiding the 50 object limit
Combine objects with the object editor. Select several objects that are on the page in their desired
final positions and use the Cut command to remove them from the page. The images are now in 
the clipboard. Open the object editor and use the Paste command. Select the checkmark to save 
the images - now a single image - to the page.

================= How To Contact Technical Support =================

When contacting technical support, please be sure to include detailed information about the 
problem you are having and include the following:
 
 Platform: Windows 3.1x or Windows 95
 Computer Type/Model: Gateway 2000
 Operating System: Windows 3.1
 RAM: 8 MB
 Video Driver: CL GD5426/28
 Sound Card: Ensoniq

Contact TLC Technical Support via e-mail at:

Internet: support@learningco.com



World Wide Web: http://www.learningco.com

You may reach Technical Support via FAX at (423) 670-2021.

To speak with a technical support representative, call (423) 670-2020 
Monday through Friday, 9 a.m. to 9 p.m. Eastern Time.

If you prefer to write a letter, please send it to:

The Learning Company Product Support Center
9715 Parkside Drive
Knoxville, TN 37922

==================================================================
We would like to extend a special thank you to Danika Allen for adding her voice to the How to 
Use Storybook Weaver story starter.


